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Experiment 1: Simulation of continuous and digital PID-Controllers

1, Introduction

Figure 1 shows a typical continuous feedback system. Almost all of the continuous
controllers can ‘be built using analog electronics.

Continuons Controller

¥

The continuous control]er,-enclos.ed in the dashed square, can be replaced by a digital

“controller, shown in Fig. 2, that performs the same control task -as the continuous

controller. The basic difference between these controllers is that the digital system
operates -on discrete signals (or samples of the sensed signal) instead. of continuous
signals. '
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The different types of signals in Fig. 2 can be representéd by the following plots: -
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Fig.3

As seen in Fig.3 the digital control system contains both discrete and the continuous
-portions. When designing a digital control system, the discrete equivalent of the
continuous portions has to be determined.

For this techmque a part of the dlgltal control system will be rearranged as seen in Fig. 4.
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The clock connected to the D/A and A/D converters supplies a pulse every T seconds
and each D/A and A/D sends a signal only when the pulse arrives. The time T is called
the sample time. The purpose of this pulse is to produce samples u(k) for Hy(z) to work
~on and to produce samples of output y(k); thus, Hyu(z) can be realized as a discrete
function. -

The philosophy of the design is as follows:. The discrete function Hzeh(z) has to be

. determined, so that for a piecewise constant input-to the continuous system H(s), the
sampled output of the continuous system equals the discrete output. Supposing the signal
u(k) represents a sample of the input signal this sample u(k) is held to produce a
continuous signal unx(t). Fig. 5 shows that the t(t) is held constant at u(k) during the
interval kT to (k+1)T. This operation of holding up«(t) constant for the sampling time is

| called zero-order hold. '
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The zero-order held signal un(t) goes through H2(s) and A/D to produce the output y(k)
that will be the piecewise same signal as if the continuous u(t) goes through H(s) to
produce the continuous output y(t) (see Fig. 6).
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Now the schematic will be redrawn by replacing the continuous portion by Hoon(z)
(Fig.7). '
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Fig.7

By the rearrangement of H(s) to Hyon(z), the digital control system can be des1gned with |
only discrete functions.

~ To get Hyon(z) the Z-Transformation of the Laplace transfer function of the plant H(s)
together with the zerd-order hold has to be determined. The transfer function of the zero-

order hold is given by (1—e™*")/s. Using the definition of z (z=¢") Hzon(z) can be
determined by '

H (s)

zoh( )_"'"'_Z{ }

" The Z-Tranformation of H(s)/s can be done by the use of transformation tables (see
Appendix).

The system with either a continuous or a discrete PID-Controller has to be simulated the
correspondmg transfer functions must be considered: .

- fora contlnuous PID-Controller the algorithm in time domain is

(=K [e(z‘)+FJ-e(z')dr+Te(r)] K e()+K, je(r)dHKde(r)

n

- the Laplace transfer function of a PID-Controller is known as

G(s)=—Y—(S—)-—K C1+L+ST) K +K + 5K,
E(s) sT,

. fora digital PID-Controller the algorithm in time domain is

Ve = Kyl + Ze +T, 2y Ko, +KTS e + K, —-f‘i-i
n 1 0 i=0 .
Ve =Kple, + | (Zoe —g )+ T (e, —e )= K e + iT(gei _ek)+?(ek -, )

- the Z-Transformation of the digital PID-Controller is



Y(Z) o I + 22 g akr 2 g Kzl
E(z) 7,z-1 T, T z. z—1 Tz
A proportlonal controller (Kp) hasthe effect of reducing the rise time and will reduce, but
never eliminate, the steady-state error. An- integral control (Ki) has the effect of
eliminating the steady-state error, but it may make the transient response worse. A
derivative control (Kd) has the effect of increasing the stability of the system, reducing
‘the overshoot, and improving the transient response. Effects of increasing each of
controllers K_p, Kd, and Ki on a closed-loop system are summarized in Table 1.

G()—

|CL RESPONSE | RISE TIME |OVERSHOOT SETTLING TIME |S-S ERROR
[ Kp | Decrease | Increase | Small Change f Decrease :
L D I
L |

[ Decrease Increase | Increase

| Ehmmatea
Small Change

Kd ISmaH Change, | Decrease |  Decrease

Table 1

Note that these correlations may not be exactly accurate, because Kp, Ki, and Kd-are
dependent of each other. In fact, changing one of these variables can change the effect of
the other two. For this reason, the Table 1 should only be used as a reference when you
are determmmg the values for Ki, Kp and Kd.

- For determmatlon of optimal control parameters the PID tuning method by Chien, Hrones
and Reswick can be used.

For that method the step response of the system without any controller has to be
measured. The result should look like the Fig. 8. After drawing a tangent at the inflection
point of the curve the system parameters Ksg (process gain), T, (time constant) and T, -
' (dead time) can be determined. '
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With these system parameters we are now able to determine optimal control parameters
according to Table 2.

Controller- Control
’I‘ype Parameters
’ WK o7k
TU
PI ) Kp K 06 E
T,
T [F
PID K K T
' ‘ 0,9571_—g
. Tn u
135T,
T. . 1047T,

Table 2

_ As. long as the sample rate is small enough, these parameters can be used for both
continuous and digital controllers. In this case the digital controller design is called
“quasi-continuous controller desxgn But the. sample rate. must fulfill the following
condition: |
T<iT,
>

In this equation T is the sample rate and Ty is the smallest system time that occurs in the
controlled system

. The second condition for a “quasi-continuous controller design” is that the sum of the

time the microcontroller needs for the calculation of the control algorithm and the time

for the D/A and A/D converters must be very small according to the sample rate. If this

- condition is not valid, we must add an additional dead time element to our system model
© to s1mulate this time consumption.



2. Experiment

Suppose we have a simple mass, spring, and damper problem.

Fig. 9

The modeling equation of this system is ' :
Mx+bx+kx=F

Taking the Laplace transform of this modeling equation
' Ms*X(s) + bsX(s) + kX(s) = F(s)

 the transfer function between the displécement X(s) and the input F(s) fheﬁ becomes
X(s) _ - -
F(s) Ms’+bs+k o

With M = 1kg, b= 10 Ns/m, k =20 N/m and F(s) = 1 we will get
. ' X(s) _ 1
F(s) s*+10s+20

2.1 Open-loop step response

Start MATLAB SIMULINK and build a model with a PT» Block simulating the system
" described above. Add a step source and a scope so that the system looks like shown in
Fig. 10. Set the step time of the source to “0” and the final value to “1”. Set the stop time
of the simulation parameters to “3” seconds and start the simulation.
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the Autoscale-Button to get a better scaled figure. Print out the open-loop step response

After a double click on the Scope you can see the step response of the system. Click on



and determine the system'parar.neters Ks, Ty and T, from the figure. Use these values to
determine the controller parameter for P PI- and PID-Controller for .our system:
according to the tuning method by Chien, Hrones and Reswick.

- 2.2 Different continuous controllers

Build a closed 100p with the PT> Block and the different types of continuous
conirollers (P-, PI- and PID). For example the closed loop with a PID-Controller
~should look like Fig. 11.
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Fig. 11

Verify the statements of the effects of rise time, overshoot, settling time and
steady-state error made above. Vary the parameters and try to find the best
parameters for all types of controllers. Print out the step responses of the systein
with the different types of continuous controllers and write down the used
parameters.

- 2.3 Digital controller

Now exchahge the continuous controller with a digital PID-controller. As the digital PID-
controller should be used as a quasi-continuous controller, the Sample t1me must be small
-enough.

Calculate both time constants of our PT,-system. Decide which one is smaller and
deterrine the limit for a quasi-continuous controller design.

In the MATLAB workspace define a constant T with a sample time that should be
smaller than the determined limit.

Build a closed loop with the system and a dlgltal PID-controller that should look
like Fig. 12. You must set the sample time of every discrete block (for example
‘the discrete transfer functions and the zero-order hold) to the constant T you
defined in the MATLAB workspace. By this it easy to change the sample rate for

~ the whole system by changmg the Value for the constant T in the MATLAB

workspace. -
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“Hint: A real digital control system will contain a sample-block with an A/D-converter

" before the digital controller and a D/A-converter afier the controller. As MATLAB
only deals with digital values (even when it simulates continuous Szgnals) these
blocks are not necessary in this laboratory.

Test the system behavior with the different digital controller-types (P-, PI-:and
PID-controller) by setting the parameters of the discrete controllers to the same
values you used for the continuous controllers.

Test the system behavior for shorter and for greater sample times. Determine the
sample time at which the system becomes unstable.

- Look at the input function of the controlled system (Scopei) This function is no -

longer a contlnuous function (as it was with a confinuous controller) but it is a
stair function.

To simulate the time consumption of the microcontroller and the A/D- and DI/A-
converter add an additional transport delay block (dead time element) to the
system as shown in Fig. 13. Test different delay times and different sample times
and determine for which delay time the system becomes unstable.
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Experiment 2: Position Control with PV- and Dead-Beat Controller

1. Introduction

In this laboratory two different types of controllers for the position-control of a servo-
motor should be designed. The first step of designing a controller is to develop the
mathematical description of the controlled system. In this lab the system is an
electrical motor. Therefore the electrical components of the motor should be
examined first. A schematic circuit of these components can be seen in Figure 1.

R, L.,
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Figure 1 — motor circuit in ﬁtﬁe-domain
Using Kirchhoff's voltage law, the following equation can be written:

V -RI -L —%—-FE =0 1.1
m dt .emf - { ]

m mTm

Since L.m << Rm the motor inductance can be disregarded Then the equatior laoks
- like following: _

[ = m _ emf - | - [1.2] -

it should be known that the back emf created by the motor is propomona! to the
motor shatft VeIOCIty o_ such that:

V. -K 0

AT L ()

m



Next the mechanical aspect of the motor should be examined. Therefore Newton’s
2n Iaw of mation to the motor shaft has to be applied:

Jé:TuT‘ [1.4]

g

‘? ﬁA‘j@ = T — Jmé-m
In this equation Ly is the load torque seen thru the gears and n, is the efficiency

MK,
of the gearbox.
The 2" |law of motion at the load of the motor is like following: | |
. o _ ;
16, =T, /éﬁ% - [1.5]

Beq is the viscous damping coefﬂCIent as seen at the output Substituting [1.4] into
[1.5], it foilows .

g m~m

18, =K, Ty ~nK,J 6 Beqé1 - el
- With "6, =K 6, and T =n.K I, (where n, is the motor efficiency), [1.6] can be
* written as: ' h

T8, + KB, + B =n,n.K, K1 nn

- Finally, combining the electrical and mechanical equatlons by substltutmg [1.3] into
[1.71 yields to the desired transfer function: : _ , oo

0(s) _ ' TN KK .81
V_(s) J R’ +(B_R m+1‘|g’l’]meKtK§)S i
e

In this equatlon the abbreviationJ, =T, +n,J K2 is used. This can be interpteted as
- being the equivalent moment of lnertla of the motor system seen at the output.

Usmg the additional abbrewatlons K, nganK K,=(B,R m+ﬂgﬂn1KmKth) and
=J_R_, this equation can be written as follows: |

eq~m’?

O, - 13

For this laboratory the values of constants used in 11.8] are following:

M, =0.9,m,, =0.69,K, =0.0077,K, = 70,B,, =0.004,]_ =0.0020842,R, =2.6 [1.10]
K



with characteristic equation:™

2. PV-Controller

This lab lnvolve's"designing a PV controller for the servo plant. There is no need for

an additional integral gain in the controller, as the main purpose of the integral gain is
to reduce the steady state error by introducing a pole located at s = 0 in the open
loop. Looking back at the derived equation [1.9], it can be seen that the plant already
has a pole at s = 0. For this reason, and for the sake of simplicity, the required
specifications will use only a proportional (P) and. velocny/denvat:ve (V) controller

‘gain.

In the classical sense, a PD controller would have the form: C(s) =K, + Kgs. Placmg
this controller into the forward path would result in mtroducmﬁn unwanted Zzero’ in
the closed loop transfer function. As a result of the ‘zero’, the closed loop transfer

~ function. no longer fits equation [2.2] (see below) and it becomes increasingly difficult

to design the controller to meet time specifications.

_For this reason the approech of a state-feedback (PV) controller is used in this

laboratory. This results in a closed loop transfer function of the form seen in equation
[2.2]. The PV controller implemented in this lab can be seen in Figure 2 below and
has the form:

Vo =K, (0~ ed)_-Kvé _ : ' [21]

oooa
oC

L

Vm {V) Theta {rd)

“Position
Setpoint

Theta

SRYIZ
Plant Mode!

dufdt

Derivative

Figure 2 - PV Gontroiler for the servoplant

- The purpose of this lab is to design a controller using the- 2nd order transfer funct|onr

representation of the form:

CDZ

G(s) = : - 2.2
) §+20m s+ - - 1221

§ 4260 s+ 02 =0 | 23]

*Coincidentally, the characteristic equations of the PV and PD controller closed loop transfer
functions are equal. A PV controller in'essence is a PD controlfer without the unwanted ‘zero’, allowing
the designer to meet the required specifications using only the characteristic equation.



2.1 For preparation for the laboratorv experiments answer the following questiohs:

1) Obtain the transfer function of the closed loop mode! in Figure 2. Extract the
characteristic equation and fit it to the form seen in equation [2.3]. Obtain two
equations expressing @, and & as functions of_Kéand _K_‘;as these are the

_only two variables in your system. Using your newly obtained formulas and
referring to your in-class notes, what changes to your response would you
expect to see by varying the values of K, and KV

(What happens to ©, when you increase/decrease K,?)
(What happens to & when you increase/decrease Ky and/or K,?).

. Keep your answers simple. (i.e. will ®_ and £ increase or decrease?)

2) Forthe in-lab portion of this experiment, you are required to design a PV
. controller that will yield the following time requirements:
» The Overshoot should be less than 5% (£ > 0.707).
+ The time to first peak should be 100ms (T, = 0.100).
Using the formulas from Questlon 1 choose values for K, and Kyto meet the
requ1rements

_ : s .
*Hint: T %0S = et 24
w,1-8 \I J/ _ .

L oversheot ™ -

3. Dead-Beat Controller

In addition to the PV-Controller a dead-beat Controller for the servo plant should be
designed in this lab. The dead-beat controller is an example of a control algorithm
specifically worked out for sampled systems. It-has no equivalent continuous time
companion. lts main idea is to bring the system's response to its expected steady
-state value after a prefixed number of samples. This number of samples depends on
the order and on the length of a possible existing dead time of the controlled system.

To perform a deadbeat design, the controller is constructed in the way that it cancels
all the unwanted system dynamics, and introduces terms such.that a specific closed-
loop transfer function is obtained. This is dependent on the type of input to be
followed (for example a step, ramp, etc.). Hence a deadbeat design is tuned for a
particular input, and care needs to be taken when a different form of input signal is -
applled

input function w,(z) is the step function. That means:

w(t) = c(t) or w_(z)= (1~-z‘1)‘1 | | [3.1]

"The pnnCIpIe design of a digital control loop can be seen in figure 3.1n this Lab the



uz(2) xz(z)
Ger(z2) |——»  GsHe(z) |

Controlier System+S&H

Figure 3 — Standard digital control loop

For the controller design the z-transformation of the controlled system is needed.

- Looking back at the derived s-transformation of the motor, the following Laplace-

transfer function was found:

G() B(S) KU
TV (s) Ks +Ks/

[3.2]

The z-transfer function Gsu.(z) consists of the Laplace—transfer function of the motor
plant together with the sample and hold block -that is needed for digital control

~ algorithms. The transfer function of a zero-order hold is given by (1- e’")/s. Using

the definition of z (z=¢""), Gsn(z) can be determined by

HZ(Z) {G(S)}—Z 12{ Ky } | [3.3]

z s*(K,s +K))

| - Using the abbreviations a:% and b_=%—’— this equation can be written as:

2 1

GSHZ(Z):bZ_iZ{ 2 } | 34

v/ s’(s+a)

With the following transformation pair the z-transfer function GSHZ(Z) can be
determined: |

I S A D c=e™ [3.5]
s*(s+a) -1 a@z-1(z-c)’ ‘ _

F(s) =

Using this transformation pair yields to:

Tz (-0 ]=baT(z-c)—(1—¢)(z—1)

'Gsm(z>=bz;1[ :
z z-1)" a(z-1(z-c¢) a(z—1}z—=c)

[3.6]

.z(bT+a Tho—a”'b)+(a'b= beT—a”bc) _(bT+a’ ’bc a“‘b)z +(ab- bcT abeyer

z_+z(1 c)+¢ _ , 14 (~1=-c)z’ _+cz



" With the use of the abbreviations 'a, =(-1-¢),a, =c,b, =(bT+a"'bc—a~'b) and
b, =(a”'b-bcT —a""bec) Gshz(z) becomes to the following:
bz +b,z7

G = : : : .3.7 |
SHZ(Z). 1+az" +a,27 ‘ - Bl

As this transformation function is of second order wnthout any delay time a dead-beat
controller should be able to bring the system's response to its expected steady state
.~ value after only two samples. That means that the expected output function of the
closed loop with the step as input function should be of the form:
X, (2)=x,+xz" +1-z27+1-27 + ... [3.8]

gt

=0

~ Thus the closed loop transfer function is: - .
22 (g 1@ 42 )] ek [3.9]

WZ(Z) 9_T crwnd onﬂ{ r

—xz T#1- (z +77 4 .) - [xz +1(z +z7 4 )]

Gclz (Z) =

=xz" +(1-x)z”
=pz " +p,z" =P(z)

with

: 2
P =EXLP,; =1_X152pi _":1

i=t

)fg. The output of the controller will be of the form;
U (2) =+ 27 F 0,2+ uz T Fuz o [3.11]

" Thus the transfer functlon between the mput of the system wz(z) and the output of the
, control[er ux(z) is:

. Z _ . _ . ~ _
Gcluz(z)=mz(l_z v, +uz™ +u,z7 +u,z 3+1122 4] [3.12]

w,(2) |
= Uy +1,Z7 FU,Z T 0,27 = [ugz T gz T gz ]
=u, +(u, - uo)z +(u2 -u)z”

=Qo+q,z +q2 =Q(z)

2 o
Gy =g, Gy = U~ UG, = Uy — Uy, > U =, o [313]

i=0

i



With these equatiens the transfer function of the controlled system can be written as:

x,2) _ Gy (2w, (2) _ P(@)

(z) = = [3.14]
SHZ 0,(z) G,.@w,(2) Q)
The closed loop transfer function of the whole system is:
Gclz(z) — XZ(Z) — Gcz(Z)GSHz(Z) [315]
W, (@) 146, (2)Gg, @)
- The equation [3.15) can be written (with the use of [3.9] and [3.14]):
@)=t Gu@ Q@ P& _ Q@) 3.46]

Ggr(z)1-Gy,(z) P(z)1-P(z) 1-P(z)

That means, that the transfer function of the dead-beat controller can be determined
from the polynomials P(z) and Q(z). The coefficients of these polynomials can be
determined . from the coefﬂcnents of the controlled system Equating [3.7] and [3.14]
yields to:

R ~2 . 1 -2
bzl +bz? Pz +p,z [3.47]
1+az +azz q0(1+qlz +Q2 )
Qo o
- Comparison of the coefficients yields to:
P =qoblspz =q,b, | '{3;18] '
q, = quavq‘z =qed,; -
With ‘
=g, b, - [3.19]
Z 0; IC' |
the parameter qo can be determined by LS+ 14

1

Qo =3

i=1 :

/ g ansp [3.20]

3.1 For the laboratory experiments prepare the following equations:

- parameters of the controlled system and the sample time T {use the values
given in [1.10]). These parameters are reqwred for the transfer function of the

Q(Z) I qz + qz_Z
~P(z) 1~ pz” +p,z”

- dead-beat controllerG,,(z) =

-~...Determine .equations - for -the--Calculation--of-'----qo, q1; G2 -p1end pz-from the- o



4. Laboratory Execution

This Iab requires you to design a Proportional + Ve[omty (PV) controller to control the
posmon of the load shaft with the following Spemflcatlons '

1. The Overshoot should be less than 5% ( 0.707). o
2. The time to first peak should be 100ms (Tp = 0.100).

4.1 Simulation of the Plant With a PV-Controller

In Simulink, open the model called “s_position_pv.mdl” in the directory “C:\Advanced
Control Labor\Exp2”. This model includes the modelled plant (SRV-02 Plant Model),

. as well as the PV controller. Kr and Kvare both set by sfider gains. Before you begin,
you must run an M-File called Setup SRV02 Exp1.m”. This file initializes all the
motor parameters and gear ratios. Click on Simulation->Starf, and bring up the
Simulated Position scope. As you monitor the response, adjust Ky and Kv using the -
slider gains. Try a variety of combinations, and note the effects of varying each

parameter.

. Make a table of system characteristics (oallandq) with respect to chang_és in

- Kpand Kv. (Hold one variable constant while adjusting the other).
*  Does the system response react to how you had theorized in section 3.1?

'Now that you are familiar with the actions of each parameter, enter in the designed
Kr and Kvthat you had calculaied to meet the system requirements.
*Note: the values should fall within the slider limits.

+  Does the response look like you had expected?
What is your percent overshoot?
. Calculate your Te. Does it match the requirements?

*Hint: To get a better resolution when calculating Tp, decrease the time range under
the parameters option of the scope.

. !

~ If the simulated response is as expected, you can move on and implement your
controller, if you are close to meeting the requirements, try fine-tuning your
~ parameters to achieve the desired response. If the response is far from the
specifications, you should re-iterate your design process and re-calculate your
conftroller gains. ' :

4.1 Implementation of the PV—Controller

“TAfter 'S'UC"CéS’SfU[]y”'Si'm{;il'ati'h:'g' 'y'OL'Ir'"ti'(iﬁt'rbll'ef"'and"a"cihieVing".ydu'l‘” desired response,

you are now ready to implement your controller and observe its effect on the physical
plant. Open the Simulink model called “g_position_pv.mdr”.

~ The model has two identical closed Ioops; one is connected similar to the simulation
block of the previous section, and the other loop. has the actuai plant in it. To better
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familiarize yourself with the model, it is suggested that you open both sub-systems to
get a better idea of the systems as well as take note of the /O connections.

- *Note: In place of a standard derivative block in the PV controller, there is placed a
derivative with a fitter in order to eliminate any high frequencies from reaching the
plant as high frequencies will in the long term damage the motor.

Before runnmg the model, you must set your final values of K; and Kvin the MATLAB
-workspace (type it in MATLAB ). You can now build the system using the WinCon-
>Build menu. You will see the model compile, and then you can use the WinCon
Server to run the system (click on the start button).

Plot the Measured Theta (deg) as well as the Position Setpoint and the Simulated
Theta (deg). This is done by clicking on the scope button in WinCon and choosing
Measured Theta (deg). Now you must choose the Position Setpoint and the
Simulated Theta (deg) signals thru the Scope->File->Variables menu.

. How does your actual plant response compare to the simulated response’?
. Is there a discrepancy in the results? If so, why?
. Calculate your system Tpand %0S. Are the values what you had expected?

*You can calculate these parameters by saving these fraces as an m-file and making
our calculations in MATLAB . You could also make your calculations directly from the
WinCon scope by zooming in on the signals. It is suggested to make these
calculations thru MA TLAB as this method will provide greater accuracy.

4.3 Slmulatlon of the Plant with a Dead-Beat Controller

in Simulink, open the model called “s_position_dead_beat.mdl” in the directory
- “C:\Advanced Control Labor\Exp2”. This model includes the modelled plant, as well
as the dead-beat controller. You must run an M-File called Setup_SRV02_Exp1.m”to
m:t:allze the motor parameters. .

Before you can start the model, you must set the desired sample time “T” and the
calculated parameters of the dead beat contro[ler (9o, Q1. G2, P1, P2) in the MATLAB
Workspace.

*Note: The parameters of the dead-beat controller are dependent on the sample
time. :

Click on Simulation->Start, and bring up the 'output” and the “input” scope. The
output signal should reach the desired steady state value after only two sample times
and without any overshoot

The smaller you choose the sample time the faster the system reaches the final

“value. But the real motor system is designed for a maximum input of 10V. Therefore ™

you should have in mind that the sample rate for the real system has got a lower limit.

Try different sample times and the corresponding parameters of the dead-beat

- controller to find the optimal controller that combines a small samp[e time and a mput
for the motor smaller than 10V. - :



4.4 Implementation of the Dead-Beat Controller

‘Open the Simulink model called “g_position_ pv mal”. The model has two identical
closed loops; one is connected similar to the simulation block of the previous section,
and the other loop has the actual plant in it.

Before running the model, you must set your final for the sample time and the
parameters of the dead-beat controller in the MATLAB Workspace (type it in
MATLAB). You can now build the system using the WinCon->Build menu. You will
see the model compile, and then you can use the WinCon Server to run the system
(click on the start button).

Plot the output_system _end the output_simulation as well as the input__ system and
the input_simulation. This is done by clicking on the scope button in WinCon and
choosing output_system). Now you must choose the other signals thru the Scope-
>File->Variables menu.

. How does your actual plant response compare to the srmulated response’?

» s there a discrepancy in the results? If so, why?

. What happens if you choose a dead-beat controller with a smaller sample
time?

. Compare the different controller types Describe the advantages and

disadvantages of each controller.
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